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About PacketPeT For Windows - Full Commercial Version



 The File Menu

The File Menu provides Load, Save and Print functions for the text editor. File Delete and program Exit 
options are also provided.

      New
    Open...
    Save
    Save As...
    Close 
 ------------------
    Print
 ------------------
    Exit        Alt+F4



 File | New

Select New from the File Menu to start a new text file. The New command opens the Edit Window, and 
clears the editor of any text already in it. If any work from the previous edit has not been saved, you will 
be given the option of doing so, before the window is cleared. 

The New command opens the Edit Window with the default name Untitled.txt. 



 Commands - Menus

      File    Edit    View    Settings    Streams    Help



 File | Open

Select Open... from the File Menu in order to load an existing file into the text Editor. If you already have 
a file in the Editor, you will be given an opportunity to save any changes. 

The Open dialog will open to permit file selection:

PacketPeT can Edit files up to 32K in size, and view or copy portions to the clip board, regardless of 
size.

Viewer Mode
Should the file be greater than 32K in size, you will be given an opportunity to Cancel, or to use PeT's 
View Mode. The viewer can read files of any size. In View Mode, the Editor's File Title is printed in 
yellow, rather than in    the usual red. Only the Copy command of the Edit menu is available in View 
Mode.



 File | Save

Select Save in order to save the contents of text Editor to disk using the current file name. To save under 
a different file name, use Save As... .

Registration Required! - This feature will not operate until your CALLSIGN and user PASSWORD 
have been entered. 

Registration



 File | Save As...

Select Save As... in order to save the current contents of the text Editor. The Save As... dialog will open 
to permit filename selection:

Registration Required! - This feature will not operate until your CALLSIGN and user PASSWORD 
have been entered. 

Registration



 File | Close

Select Close to close the Editor window. If the text in the Editor has not been saved, you will be given an 
opportunity to do so.

Hot Keys: 



 File | Print

Select Print in order to send the current contents of the text Editor to the printer.

Registration Required - This feature does not operate until you have entered your Callsign and user 
Password.

Registration



 File | Exit

Select Exit in order to Shut down your PacketPeT session. You will be given the option to save any 
unsaved changes in the text Editor before exiting.



 The Edit Menu

The Edit Menu provides the basic text editing commands. It also provides commands to Save, Edit and 
Clear the contents of the Receive and Transmit buffers, and to send selected text in the Editor to the Tnc.

 
 Undo         Alt+BkSp 
 Cut         Shift+Del
 Copy         Ctrl+Ins 
 Paste         Shift+Ins 
 SelectAll         Alt+Ctrl+A
 Delete         Del 
 Send Selected         Alt+Ctrl+S
 ------------------------------------------
 Edit Recv         Shift+F2 
 Save As.. Recv         Shift+F3 
 Clear Recv         Shift+F4 
 ------------------------------------------ 
 Edit Xmit         F2 
 Save As...    Xmit         F3 
 Clear Xmit         F4



 The View Menu

The View Menu supports the view of the Receive, Transmit, and Editor Panes. The Editor Panes can not 
be made visible unless the Editor has first been opened with the New, Open, Edit Recv or Edit Xmit 
commands.

      Recv Full F5
    Recv > Xmit Shift+F5
    Recv < Xmit Ctrl+F5
 *All IO|Recv|Xmit Alt+F5
 ---------------------------------------------------
    Edit Full F6
    Recv > Edit Shift+F6
    Recv < Edit Ctrl+F6
    *All IO|Recv|Edit Alt+F6
 ----------------------------------------------------------------
    Scroll Bars                          -> 
     Recv Horizontal Scroll Bar

 Recv Vertical Scroll Bar

----------------------------------------
       Xmit Horizontal Scroll Bar

 Xmit Vertical Scroll Bar



 The Settings Menu

The Settings Menu provides access to configuration and users options.

     Directories
    Packet
    Serial Port
    Terminal Colors
    Terminal Preferences
 ------------------------------------
    Ansi Color Shift+F10
    Ansi Reset Ctrl+F10
    Save Settings On Exit
 ------------------------------------
    Register Call
 ------------------------------------
    Save Connects
    Log Connects
 ------------------------------------
    Stamp
    Mon To File
  
  



 The Help Menu

The Help Menu provides commands for accessing help in configuring and using PacketPeT, along with 
other reference information. 

    Using
    Index                      F1
 ----------------------------
    About...



 Edit | Undo

The Undo command takes back your last Editor action.    It can be used to restore the last deleted 
charactor, or to undo a cut / paste operation. Beware that it does NOT undo Clear Recv/Xmit commands!

Hot Keys:    

                        or                  



 Edit | Cut

The Cut command removes the selected text from the Editor and copies it to the windows clipboard for 
subsequent paste operations.

Hot Keys:      

                          or                

Registration Required - This feature does not operate until your CALLSIGN and user PASSWORD 
have been entered! 

Registration



 Select

Text is selected in the standard Windows manner, by pressing the left mouse button and dragging the 
mouse cursor over the desired text or, using the keyboard, holding the Shift key while using arrow keys to 
move the cursor over the desired text. The selected text is marked by highlighting.

Note:
To select all of the Editor's text, use Select All.



 Edit | Copy

The Copy command copies selected text from the Editor to the windows clipboard for subsequent paste 
operations.

Hot Keys:      

                          or                

Registration Required - This feature does not operate until your CALLSIGN and user PASSWORD 
have been entered! 

Registration



 Edit | Paste

The Paste command will insert the text on the clipboard, if any, at the current cursor position on the Editor 
pane. If text on the Editor pane is selected (highlighted) at the time of paste, it will be replaced by the 
pasted text.

Hot Keys:      

                        or                    



 Edit | Select All

The Select All command selects (highlights) all text currently residing in the Editor.

Hot Keys: 



Edit | Delete

The Delete command will remove selected text from the Editor.

Hot Key:      



Edit | Send Selected

The Send Selected command will send the selected portion of the text in the Editor to the TNC.

Hot Keys:    

Registration Required - This feature does not operate until your CALLSIGN and user PASSWORD 
have been entered! 

Registration



 Edit | Edit Recv

The Edit Receive command opens the text Editor and copies the contents of the Receive buffer into the 
Editor.

Hot Keys:    



 Edit | Save As... Recv

The Save As... Receive command is used to save the contents of the Receive Buffer. The Save As... 
dialog opens to permit selection of a filename:

The default filename is RECVBUFF.TXT.

Hot Keys:    

Registration Required - This feature does not operate until your CALLSIGN and user PASSWORD 
have been entered!

Registration



 Edit | Clear Recv

The Clear Receive command clears the contents of the Receive Buffer and the Receive Pane. The user 
is given a chance to back out, but once the buffer is cleared it can NOT be undone.

Hot Keys:    



 Edit | Edit Xmit

The Edit Transmit command opens the text Editor and copies the contents of the Transmit buffer into the 
Editor.

Hot Key:    



 Edit | Save As... Xmit

The Save As... Transmit command is used to save the contents of the Transmit Buffer. The Save As... 
dialog opens to permit selection of a filename:

The default filename is XMITBUFF.TXT.

Hot Keys:    

Registration Required - This feature does not operate until your CALLSIGN and user PASSWORD 
have been entered!

Registration



 Edit | Clear Xmit

The Clear Transmit command clears the contents of the Transmit Buffer and the Transmit Pane. The 
user is given a chance to back out, but once the buffer is cleared it can NOT be undone.

Hot Key:    
 



 View | Recv Full

The Receive Full command will hide the Transmit or Editor Pane and enlarge the Receive Pane to it's 
maximum size. If you touch any key on the keyboard, the Transmit Pane will again become visible and 
the Receive Pane will revert to it's last size prior to going full. 

Receive Full

Hot Key:    



 View | Recv > Xmit

The Receive Greater Than Transmit command will display the Receive and Transmit Panes with the 
Receive Pane larger than the Transmit Pane.

Receive > Transmit

Hot Keys:    

Note: 

The Transmit Button  can also be used access this command.



 View | Recv < Xmit

The Receive Less Than Transmit command will display the Receive and Transmit Panes with the 
Receive Pane smaller than the Transmit Pane.

Receive < Transmit

Hot Keys:      
 
Note: 

The Transmit Button  can also be used access this command.



 View | *All IO|Recv|Xmit

This command will display the *All IO (All Receive IO), (Stream Recv IO), and Transmit Panes.

          *All IO|Recv|Xmit

 Hot Keys: 



 View | Edit Full

The Edit Full command will hide the Receive and Transmit Panes and enlarge the Editor Pane to it's 
maximum size. 

Edit Full

Hot Key:    

Note: 

You can use the Edit Button  to revert to the last Receive / Edit split size.



 View | Recv > Edit

The Receive Greater Than Editor command will display the Receive and Editor Panes with the Receive 
Pane larger than the Editor Pane. This command is only available if the text Editor has previously been 
opened using the New, Open, Edit Receive or Edit Transmit commands.

Receive > Edit

Hot Keys:      

Note: 

The Edit Button  can also be used access this command.



 View | Recv < Edit

The Receive Greater Than Editor command will display the Receive and Editor Panes with the Receive 
Pane smaller than the Editor Pane. This command is only available if the text Editor has previously been 
opened using the New, Open, Edit Receive or Edit Transmit commands.

Receive < Edit

Hot Keys:      

Note: 

The Edit Button  can also be used access this command.



 View | *All IO|Recv|Edit

This command will display the *All IO (All Receive IO), (Stream Recv IO), and Edit Panes.

              *All IO|Recv|Edit

Hot Keys: 



 Settings | Serial Port

The Serial Port command opens a dialog box which is used to set the Com port, baud rate, word length 
(Data Bits), parity, and stop bits of the serial port that your TNC is connected to.

Choose the settings for which your TNC is currently configured. If PacketPet is unable to open 
the requested Com Port you will receive an error message and a chance to try again.

Many TNCs are initialized to a word length (Data Bits) of 7 bits, but it is important to realize that in 
order to display the full character set and color graphics, a word length of 8 bits is necessary.    
(PacketPeT does not permit binary characters to clear it's screen or cause the other problems that often 
occur when normal terminal software is configured for 8 bits on a busy packet channel.)

The baud rate between your Com Port and TNC should be as high as possible for best 
PacketPeT performance. Baud rates up to 38400 are supported by PeT. Since this baud rate does not 
affect the baud rate used over your radio, there is little reason not to run the fastest possible baud rate on 
TNC serial links.

Suggested final settings are 38400, 19200 or 9600, 8 bits, No Parity, Stop 1.    To achieve this you 
should save these settings to your TNC and restart your TNC with the new settings. Next, bring up the 
above dialog box using the Serial Port command on the Settings Menu and configure your PeT session to 
match. Then, use Save As..., Settings to save your new PeT session.

Notes:
1. Your Serial Port settings are saved in the file SETTINGS.PET, provided you have entered your 

CALLSIGN and REGISTRATION. 

2. Some TNCs such as the TNC2 types have their baud rates selected by hardware dip switch rather 
than by a sofware command.

Registration



SEE TNC SERIAL PORT SETTINGS:
ABaud
Abit
AWlen
PARity
Tbaud



 Settings | Terminal Colors

The Terminal Colors command opens a dialog box that supports color changes to the Receive and 
Transmit Panes.

One of the following color schemes may be selected:

Windows Default:
These are the current Windows System colors which are set by the Colors icon of the Windows Control 
Panel.

Pet Atari ST Default: 
These are the colors used by the Atari ST program Pack-Et-Term. (PET for short!)

Custom: 
These colors are adjustable. Select Receive Text, Receive Background, Transmit Text or Transmit 
Background and then move the scroll bars to make color adjustments while watching the changes to the 
Receive and Transmit Panes.

Note: 
The color settings are saved in the file SETTINGS.PET, assuming the registration has been completed.



 Settings | Terminal Preferences

The Terminal Preferences command opens a dialog box that is used to select various terminal options 
including sound, fonts, cursor and Receive Pane Columns.

The following options may be selected from the Terminal Preferences dialog:

Sound Connects 
This setting enables sound for connection changes.

Sound Bells 
This option enables sound for incoming bell control characters (Control-G).

Sound Voice
This option enables the voice which speaks the "PacketPeT For Windows" and the "73s" messages.

Fonts: 
PacketPeT supports available fixed pitch (width) fonts. Once selected the same font is used for both the 
Receive and Transmit Panes. The new font does not take effect until after the dialog is closed by 
selecting the [OK] button.

The Terminal Font must be selected for proper display of Ansi graphics, brags, etc. You must also have 
your serial port set to 8 bits, and 8bitconv set to on!

Cursor Block: 
This option changes the Transmit Pane text cursor (caret) to a block.

Cursor Line: 
This option changes the Transmit Pane text cursor (caret) to a vertical line.

Curson Blink: 
This option when enabled will cause the cursor to blink off and on.

Receive Pane Columns: 
This option determines the place at which text written to the Receive buffer is line wrapped. 



Window Width - The line wraps when the received text approaches the right side of the Receive 
Pane at the windows current width.

80 Columns - The line wraps when the received text approaches 80 columns.

128 Columns - The line wraps when the receive text approaches 120 columns.

Note: 
The Terminal Preference settings are saved in the file SETTINGS.PET,    only if the registration has 
been completed.



 Settings | Save Settings On Exit

The Save Settings On Exit command enables or disabled the saving of user preferences to the 
SETTINGS.PET file at the time the program is exited. The settings are only saved if the registration has 
been completed!

Registration Required! - This feature will not operate until your CALLSIGN and user PASSWORD have 
been entered. 

Registration



 Settings | Register Call

The Register Call command permits entry of your amateur call sign and PacketPeT user Password in 
order to complete your registration.

      

Enter your call in the top Edit box and then tab over to the Password box and enter your Password. If 
there is an error, you will be prompted for corrections.

The Call Sign and Password are stored in the file SETTINS.PET and need be entered only once.

See: 
Registration
PacketPeT License



 Settings | Save Connects

The Save Connects command enables or disables PeT's save while connected feature.

When enabled incoming text will be saved providing you have one or more connected channels. 

The text is saved with the file name ddmmmyy.con (example 13jan93.con).

When this feature is enabled and connects occur a new file will be created daily.

Registration Required! - This feature will not operate until your CALLSIGN and user PASSWORD 
have been entered. 

Registration



 Settings | Log Connects

The Log Connects command is used to enable and disable the logging feature. 

When enabled Log Connects will save connect and disconnect event information to a file in the 
format MMMYY.LOG (example JAN93.LOG).

When this feature is enabled a new log file will be created monthly.

Registration Required! - This feature will not operate until your CALLSIGN and user PASSWORD 
have been entered. 

Registration

See: 
Settings - Save Connects



 Settings | Stamp

The Stamp command enables or disables PeT's time stamping feature.    When enabled each received 
page is time / date stamped with the computers system time.



 Settings | Mon To File

The Mon To File command enables or disables the monitor to file feature. 

When enabled text received is saved to a file with the file name ddmmmyyp.mon where:
dd = day of the month
mmm = month
yy = Year
p = Com Port
MON = file extension

Example: 23jan932.mon = 23rd day, January, 1993, Com 2

Registration Required! - This feature will not operate until your CALLSIGN and user PASSWORD 
have been entered. 

Registration



 Software License

CHUCK HARRINGTON SOFTWARE, INC. grants you    the Unregistered user the right to run PacketPeT 
Lite For Windows Version 2.0 SHAREWARE for one week.    At the end of this trial period you must 
either register it, or totally remove it from your systems. 

CHUCK HARRINGTON SOFTWARE, INC. grants you the Registered user the right to use PacketPeT 
Lite For Windows Version 2.0 Registered Shareware for as long as you    wish, on as many computers 
and TNCs as you wish, provided it is run under your own Amateur CallSign. The REGISTRATION is 
granted by Amateur CallSign, and is not transferable. 

All users may pass copies of PacketPeT Lite For Windows to their friends for their trial, or upload 
it to bulletin board systems.    Beyond these priviledges, you may not modify, disassemble or merge 
copies of this program.    Furthermore  you may not rent, lease, sublicense, or assign this software.

Shareware vendors may charge a modest fee to distribute this software, but that fee may not to exceed 
$10 USA in any case. The purchase of media containing this software from any party other than CHUCK 
HARRINGTON SOFTWARE, INC, does not constitute registration of the product, and the software is 
subject to the above Unregistered User license provisions.

At any rate, this software remains the sole property of CHUCK HARRINGTON SOFTWARE, INC.

Disclaimer of Warranty



 Disclaimer of Warranty

This program and it's documentation are offered without warranty of any kind. CHUCK HARRINGTON 
SOFTWARE, INC. makes no claim as to it's suitability for any purpose. This program is AS IS, and 
changes may be made to it at any time without incurring any obligations to former users. The entire risk 
arising from the use of this product remains with the user.

IN NO CASE WILL CHUCK HARRINGTON SOFTWARE, INC. BE LIABLE FOR ANY LOSS OR 
DAMAGES INCURRED FROM USING THIS PRODUCT.

Some states do not allow the limitations of liability, so the above limitations may not apply to you. This 
agreement shall be governed by the laws of the State of Florida.



 PacketPeT For Windows

PacketPeT For Windows FULL COMMERCIAL VERSION has many additional features not included in 
PacketPeT Lite. Some of the additional features included are:

1. Operate hassle free multiple connections on a single Data Controller or TNC. This support is 
implemented for TAPR TNC2s and TNC2 clones, which includes many TNCs such as MFJ and 
PacComm.    Also supported are the Kantronics KAM/KAM+ DUAL PORT,    KPC3, PK900 and AEA 
PK88/232 types.

2. Macro language supports multiple mode opertion, and various other kinds of enhanced    
automatic and command line operations.

3. Marco Recorder automatically creates Macro files from your keystrokes.

4. Macro Player permits automatic (robot) type of operation at set times or intervals and at PacketPeT 
startup or shutdown. This is useful for many different purposes such as automatic CQs or 
Connections. You can easily set this feature to log on to your local VHF mailbox and retrieve you 
mail for you while you are sleeping or away from home. You may automatically reconfigure your TNC 
at PeT startup or shutdown, or easily change your settings for whatever purpose you desire. PeT 
Macros put YOU in control of your TNC or DATA CONTROLLER and are one of the most powerful 
features of PeT.

5. Binary Transfers in a modified XMODEM transfer protocal (and yet XMODEM COMPATABLE!) that 
permits a file transfer with a CHAT in the background on virtually any TNC, even the old TAPR 
TNC1s or HEATH HD-4040s! Two PacketPeT stations can exchange program files (shareware 
please!) and have a keyboard chat during the transfer!

6. Additional Text File Transfer features.

7. 27 User Definable menus further permit the customizations of PacketPet to YOUR desires and 
purposes! This is a very nice feature!

8. Support for multiple Data Controllers or TNCs running on the same computer. Use up to four TNCs 
simultaniously with Windows 3.1 or OS2 2.1!    Each TNC will have it's own Main Window and 
configuration. Use a TNC2, a KAM, a PK232, and a TNC1 if you wish, all at the same time! The 
PacketPeT manual includes tips on how to get your PC to use up to four serial ports at the same 
time without conflicts!

9. File Delete utility permits cleaning up unwanted files without switching away from PeT.

11. File Menu maintains a most recently used file list to quickly reopen files.

12.The Sessions feature permits you to have many different kinds of configurations that you can easily 
invoke using the Windows Associate Feature or from a popup dialog box at PeT run time.

13. Additonal sound support. PeT speaks the calls of connected stations. Add sound to your own macros!

Look:
AEA Support
KAM Support
TNC2 Support - Includes most MFJ, PacComm, etc.



PacketPeT For Windows - FULL COMMERCIAL VERSION comes with a hardcopy user manual and 
at only $49.95    is one of the best bargains in Amateur Radio Software. 

Registered Users of the PacketPeT Lite can upgrade to PacketPeT For Windows - FULL VERSION for 
only $24.95, plus $3.00 shipping and handling plus any applicable sales taxes (Florida residents!).



 Registering PeT Lite

PacketPeT Lite For Windows is licensed by Amateur CallSign. When you register PeT, you will be 
sent a Password which will enable additional PeT features including:

1. Settings | Save On Exit permits the    saving of baud rates, user registration and other user 
preferences.

2. PeT notifies you when someone connects and PeT's Window is hidden! 

3. Integrated Text Editor File | Save - Save and File | SaveAs features are enabled!    Editor's Cut, 
Paste and Send Selected features are enabled.

4. Settings | Log Connects feature is enabled!

5. Settings | Save Connects feature is enabled!

6. File | Print feature is enabled.

7. Settings | Ansi ColorGraphics reception is enabled.

8. Settings | Monitor to File file feature is enabled.

9. Edit | SaveAs RECV and Edit | SaveAs    XMIT features are enabled.

10. Settings | Packet can be disabled for improved Pactor / RTTY operation.

To Register PacketPeT Lite For Windows send $25.00 USA and your AMATEUR CALL SIGN to: 

CHUCK HARRINGTON SOFTWARE INC.
1565 BRAZILIAN LANE
WINTER PARK, FLORIDA 32792

INFORMATION / SUPPORT              (407) 679-9017      -      Ask for Chuck!

Registration by mail only!    Sorry, but we are not setup to register by phone at this time. Your patience 
on this is appreciated and will help to keep the cost of PeT Lite down. Thankyou!

For your convience, an order form is included among the decompressed shareware files with the filename 
order.txt.

PLEASE REMEMBER TO INCLUDE YOUR HAM CALL WITH THE ORDER!

We will ship you a disk (3 1/2 inch standard, 5 inch on request) with the latest version of 
PacketPeT Lite For Windows, and your Password. Should you later desire to upgrade to the full 
RETAIL VERSION of this program, PacketPeT For Windows, you will receive credit for this $25 
Shareware registration fee. 

Additional Users:
Additional Passwords are available at a cost of $5 each, provided all CallSigns licensed are shown to 



be either the same person, or diffferent persons residing at the same address, and that this can be 
confirmed by the CALLBOOK.

PacketPeT For Windows - Full Commercial Version



 Edit Button 

The Edit Button will appear above the right hand size of the Transmit / Edit Pane when the text Editor 
has been activated by the New, Open, Edit Recv or Edit Xmit commands.

If the Editor Pane is currently showing and the Edit Button is clicked, the Panes will alternately 
toggle between Receive > Edit and Receive < Edit. 

If the Edit Button is clicked when the Transmit Pane is showing, the Transmit Pane will be 
hidden and the Edit Pane will be shown.

 - The Receive Button

 - The Transmit Button



 Panes

Each PacketPeT Session Window is divided into one, two or three Panes:

Receive > Transmit Split

When the PeT Session has the Receive and Transmit Panes both showing, the Receive Pane is 
displayed at the Session window top, and the Transmit Pane at the Session Window bottom. This split 
may be displayed in two sizes:

Receive Less Than Transmit - Recv < Xmit
Receive Greater Than Transmit - Recv > Xmit

*Recv | Recv | Xmit Split

When the *All IO Receive, A - Stream and Transmit Panes are all showing, the All IO Pane is dislayed at 
the top, the A - Stream at the center, and the Transmit at the bottom of the session Window.

Receive < Edit Split

When the Receive and Editor Panes are both showing, the Receive Pane is displayed at the Session 
window top, and the Editor Pane at the Session Window bottom. This split may be displayed in two sizes:

Receive Less Than Edit - Recv < Edit
Receive Greater Than Edit - Recv > Edit

Receive Full

The Receive Pane takes up the entire PacketPeT Session work area. Touch any key in this condition will 
cause a return to the last Receive - Transmit split size.

Edit Full 



The Edit Pane takes up the entire PacketPet Session work area.



 Receive Button 

The Receive Button is placed to the right of the System Time:

If the PeT Session is currently showing any split condition, Receive > Edit, Receive < Edit, 
Receive > Transmit or Receive <    Transmit, then clicking the Receive Button will change the Window 
Split to Receive Full.

If the Receive Button is clicked during the Receive Full or Edit Full condition, then the Window 
Split will revert to the last Recv - Xmit split. (note that during Recv Full touching any keyboard key will 
have the same effect.)

 - The Edit Button

 - The Transmit Button



 View | Recv Horizontal Scroll Bar

This option lets you determine whether the Recv Pane's Horizontal Scroll Bar will be displayed. The 
Receive Horizontal Scroll Bar is used to move the view of received text horizontally in order to see text 
that extends beyond the window. 

When the Recv Pane's Horizontal Scroll Bar is hidden, keyboard commands may be used to move 
through the Transmit Buffer:

 - Move Receive Pane view left.

 - Move Receive Pane view right.



 View | Xmit Horizontal Scroll Bar

This option lets you determine whether the Xmit Pane's Horizontal Scroll Bar will be displayed. The 
Transmit Horizontal Scroll Bar is used to move the view of Transmit Pane text horizontally in order to see 
text that extends beyond the window. 

When the Xmit Pane's Horizontal Scroll Bar is hidden, keyboard commands may be used to move 
through the Transmit Buffer:

 - Move Transmit Pane view left.

 - Move Transmit Pane view right.



 View | Xmit Vertical Scroll Bar

This option lets you determine whether the Xmit Pane's Vertical Scroll Bar will be displayed. The Transmit 
Vertical Scroll Bar is used to move the view of Transmit Pane text vertically in order to see text that 
extends beyond the window. 

When the Transmit Pane's Vertical Scroll Bar is hidden,    keyboard commands may be used to move 
through the Transmit Buffer: 

 - Move Transmit Pane view up.

 - Move Tramsit Pane view down.

 - Move Transmit Pane view to top.

 - Move Transmit Pane view to bottom.



 View | Recv Vertical Scroll Bar

This option lets you determine whether the Receive Pane's Vertical Scroll Bar will be displayed. The 
Receive Vertical Scroll Bar is used to move the view of Receive Pane text vertically in order to see text 
that extends beyond the window. 

When the Receive Pane's Vertical Scroll Bar is hidden, keyboard commands may be used to move 
through the Receive Buffer: 

-    Move Receive Pane view up.

-    Move Receive Pane view down.

-    Move Receive Pane view to top.

-    Move Receive Pane view to bottom.



 The A - Stream Button 

Select the A - Stream Button to make the A - Stream your main Receive Pane.

This Pane is filtered so that communications between the TNC and PeT such as checking connect status 
are not shown. 

It also has the option of ANSI color graphics, which may be enabled once the registration has been 
completed.

PeT Lite has only a single stream, where in the full RETAIL VERSION, PacketPeT For Windows, there 
are 10 streams for the the AEA and TNC2 types, and 20 Streams for the KAM dual port controller.



 Streams |    A - Stream

The A - Stream menu selection switches the Receive and Transmit Panes from the *All IO (raw) to the A - 
Stream view.

Select Streams | A - Stream Button to make the A - Stream your main Receive Pane. 

This Pane is filtered so that communications between the TNC and PeT such as checking 
connect status are not shown. 

It also has the option of ANSI color graphics, which may be enabled once the registration has 
been completed.

Note:
PeT Lite has only a single stream, where in the full RETAIL VERSION, PacketPeT For Windows, there 
are 10 streams for the the AEA and TNC2 types, and 20 Streams for the KAM dual port controller.



 Streams | All IO

The *All IO menu selection selects the raw receive IO channel as the main Receive Pane.

Select *ALL IO when you want to see raw IO as your main Receive Pane and Transmit Panes. The main 
Receive Pane is always the first Pane display above the Transmit or Edit Pane. 

The *Recv | Recv | Xmit option permits you to display this Pane along with the A - Stream simultaniously. 
This is very useful when you are listing the messages on a mailbox, because you can scroll back in the 
ALL IO Pane to look at previously received message headings, while the    A - Stream IO Pane is showing 
the currently received text.

Note:
The incoming text is not filtered by PeT, and ANSI Color will NOT work on this Pane.



 The *ALL IO Button 

The All IO Button is display below the menu bar in the upper left corner of the main PeT Window.

Select The ALL IO Button when you want to see ALL RECEIVE IO as your main receive Pane. The main 
Receive Pane is always the first Pane display above the Transmit or Edit Pane. 

The *Recv | Recv | Xmit option permits you to display this Pane along with the A - Stream simultaniously. 
This is very useful when you are listing the messages on a mailbox, because you can scroll back in the 
ALL IO Pane to look at previously received message headings, while the    A - Stream IO Pane is showing 
the currently received text.

Note:
The incoming text is not filtered by PeT, and ANSI Color will NOT work on this Pane.



 Button Controls

The Edit Button 

The Cstatus Button 

The *ALL IO Button 

The A Stream Button 

The Receive Button 

The Transmit Button 



 The Transmit Button 

The Transmit button is placed at the bottom left corner of the Receive pane:

If the PeT Session is currently showing a Receive - Transmit split, then clicking the Transmit 
Button will cause the split to alternate between Receive > Transmit and Receive < Transmit.

If the PeT Session is currently showing the Edit pane, then clicking the Transmit Button will 
cause the Transmit Pane to be made visible and the Edit pane to be hidden. The text in the Editor is still 
there, and you can return to the Editor by using the Edit Button or by selecting the Editor from the View 
menu.

If the Transmit Button is clicked during the Receive Full or Edit Full condition, then the Pet 
Session View will revert to the last Receive - Transmit split.

h:\hlpmagic\bmp\e.bmp - The Edit Button

h:\hlpmagic\bmp\r.bmp - The Receive Button



 Hot Keys 

Editor:
Alt+Backspace     -          Edit | Undo
Shift+Del    or    Ctrl+X     -          Edit | Cut
Ctrl+Ins          or    Ctrl+C     -          Edit | Copy
Shift+Ins      or    Ctrl+V     -          Edit | Paste
Alt+Ctrl+A     -          Edit | Select All
Del     -          Edit | Delete
Alt+Ctrl+S               -          Edit | Send Selected
Shift+F2     -          Edit Receive Buffer
Shift+F3     -          Edit | Save As... Receive Buffer
Shift+F4     -          Edit | Clear Receive Buffer
F2     -          Edit Transmit Buffer
F3     -          Edit | Save As... Transmit Buffer
F4     -          Edit | Clear Transmit Buffer

View:
F5     -          View | Receive Full
Shift+F5     -          View | Receive > Transmit View
Ctrl+F5     -          View | Receive < Transmit View
Alt+F5     -          View | *All Receive | Receive | Transmit
F6     -          View | Editor Full View
Shift+F6     -          View | Receive > Editor
Ctrl+F6     -          View | Receive < Editor
Alt+F6     -          View | *All Receive | Receive | Editor

Settings:
Shift+F10     -          Settings | Ansi Color
Ctrl+F10     -          Settings | Ansi Reset

See:
Receive Horizontal Scroll Bar
Receive Vertical Scroll Bar
Transmit Horizontal Scroll Bar
Transmit Vertical Scroll Bar



 Window Title Bar

The Title Bar shows the name PacketPeT Lite- Unregistered, until you have entered your CALLSIGN 
and user PASSWORD.    Afterwards, the title bar will show the name PacketPeT Lite - CALLSIGN. 

The Title Bar can also be used to move a window. Point at the Title Bar with the mouse cursor, 
and while holding down the left mouse button, move the mouse in order to relocate the window on the 
screen.

Double Click the Title Bar to maximize the window or double click to restore to the previous size.



 Window Controls

Maximize / Restore
Minimize
Receive Horizontal Scroll Bar
Receive Vertical Scroll Bar
System Menu
Transmit Horizontal Scroll Bar
Transmit Vertical Scroll Bar
Title Bar



 Recv Vertical Scroll Bar

The Receive Vertical Scroll Bar moves the view of the main Receive Pane text vertically to display the 
text that extends beyond the window. 

View | Recv Vertical Scroll Bar



 Recv Horizontal Scroll Bar

The Receive Horizontal Scroll Bar moves the view of main Receive Pane text horizontally to display the 
text that extends beyond the window. 

View | Recv Horizontal Scroll Bar



 Xmit Vertical Scroll Bar

The Transmit Vertical Scroll Bar moves the view of Transmit Pane text vertically to display the text that 
extends beyond the window. 

View | Xmit Vertical Scroll Bar



 Xmit Horizontal Scroll Bar

The Transmit Horizontal Scroll Bar moves the view of the Transmit Pane text horizontally to display the 
text that extends beyond the window. 

View | Xmit Horizontal Scroll Bar



 System Menu

The Control Menu Button appears in the upper-left corner of your PeT session window. Clicking it or using 
the <Alt> + <Space Bar> combination will bring up the System Menu, which is especially useful for sizing 
or moving the main PeT window from the keyboard.

---------------------------
Restore                                                      -    Restore Window to previous size.
Move                                                                -    Use keys to move Window.
Size                                                                    -    Use keys to alter Window size.
Minimize                                                    -    Shrink Session Window to Icon.
Maximinze                                            -    Session Window Full or Restore.
---------------------------
Close                    Alt+F4                  -    Exit this PeT Session.
---------------------------
Swtich to... Ctrl+Esc          -    Shows Windows Task List.
_________________



    Cstatus Button 

The Cstatus Button is located to the right of the Connects:Y status indicator:

Clicking on the Cstatus Button brings up the TNC Connect Status window.

The Connect Status shown will reflect the the status of the current TNC Stream/Channel.



 Window Maximize / Restore

The Maximize Button can be use to maximize the PeT Session Window or restore it to its previous size.



 Window Minimize

The Minimize Button is used to shrink the PeT Session Window to an icon on the Windows desktop. 

When minimized, PeT is still running.    Should a change in connection take place, a popup 
window will notify the user and provide an opportunity to restore the Session Window.

To restore the PeT Session Window to it's original size, double click on the PeT icon on the 
Windows desktop.



 TBaud

On AEA PK88 and PK232 controllers, the TBaud command sets the baud rate for the serial port that the 
TNC uses to communicate with with the computer.

TBaud n<Return> 

Where n = 110 to 19200 Baud on the PK88, and 45 to 9600 on the PK232.    The new baud rate does not 
take effect until the TNC is restarted. 

Recommend Setting for PeT:
ABaud 9600 (or the highest possible)

To set PeT's baud rate use Settings|Serial port.

Models:
PK88
PK232



 ABaud

The ABaud command sets the baud rate on the serial port that the TNC uses to communicate with with 
the computer on Kantronics and TNC1 type controllers. 

On AEA, Abaud is used to set the baud rate for the ASCII operating mode only! PK88 and PK232 
users should use the TBaud command to set the serial port baud rate.

ABaud n<Return> 

Where n = 110 to 19200 Baud on TNC1, and 300 - 9600 on Kantronics.    The new baud rate does not 
take effect until the TNC is restarted. 

Recommend Setting for PeT:
ABaud 19200 (or the highest possible)

To set PeT's baud rate use Settings|Serial port.

Models:
TNC1/HD-4040 
Kantronics



 Tnc Settings

This list contains those TNC settings which are necessary for PacketPeT Lite to operate correctly. Other 
TNC commands not on this list do not directly effect the implementation of PeT's features.

8BItconv PeT On All but TNC1
ABaud PeT Highest TNC1, Kantronics
ABIt PeT 1 TNC1
ACRDisp PeT 0 AEA
ALFDisp PeT On AEA
AUtolf PeT On All but AEA
AWlen PeT 8 All
BBSmsgs PeT Off AEA
BKondel PeT On All
CASedisp PeT 0 AEA
CBell PeT Off AEA
COMmand PeT $03 All
CONMode PeT Conv All
CR PeT On All
DELete PeT Off All
ECHO PeT Off All
ESCAPE PeT Off All
FLOW PeT Off All
HOST PeT Off AEA
INtface PeT TERMINAL Kantronics
Lcok PeT On All but AEA
Paclen PeT 128 All
PARity PeT None All
Screenl PeT 0 All but AEA
STArt PeT $11 All
STOp PeT $13 All
TBaud PeT 9600 AEA
XFlow PeT Off All



 ABIt

The ABIt command    selects the number of Stop Bits that the TNC's serial port uses to communicate with 
the computer. The new setting takes effect when the TNC is restarted.

ABIt n<Return> Where n = 1 or 2.

Recommended Setting for PeT: Use 1 Stop Bit.
ABIt 1

To set PeT's stop bits use Settings|Serial Port.

Models:
TNC1/HD-4040



 AUtolf

The AUtolf command enables or disabled the adding of linefeeds ($0A) to the end of received lines.

AUtolf On|Off<Return> 

Required Setting for PeT: Enable Line Feeds.
AUtolf ON

Models:
All but AEA

See:
AEA ALFDisp ON|OFF



 AWlen

The AWlen command sets the word length used by the TNC's serial port to communicate with the 
Computer. The new setting takes effect when the TNC is restarted.

AWlen n<Return> Where n = 7 or 8.

Required Setting for PeT: Set Word length to 8.
AWlen 8

To set PeT's word length (Data Bits) use Settings|Serial Port.

Models:
All

Note:
If AWlen is not set to 8 bits PeT will not be able to display a full character set.



 8Bitconv

The 8Bitconv command tells the TNC to use all 8 bits in converse mode.

8Bitconv On|Off<Return>

Recommended setting for PeT: Use 8 bits in Converse.
8Bitconv On

Models:
All but TNC1 / HD-4040.

Note:
If 8Bitconv is off the most significant bit will be stripped, and PeT will be unable to send or display the 
full character set.    Also, the TNC's serial interface and PeT's Data Bits (word length) must be set to 8 
bits in order the 8th bit to be used.

See:
AWlen
Settings|Serial Port



 ALFDisp

The ALFDisp command enables or disabled the adding of linefeeds ($0A) to the end of received lines.

ALFDisp On|Off<Return> 

Required Setting for PeT: Enable Line Feeds.
ALFDisp ON

Models: 
AEA PK-88/232

See: 
Autolf



 BBSmsgs

The BBSmsgs command surpresses TAPR style status messages.

BBSmsgs On|Off<Return>

Required for PeT: Permit TAPR status messages.
BBSmsgs Off

Models:
AEA



 BKondel

The Bkondel command determines how a charactor is deleted in command and coverse mode. Bkondel 
On erases a charactor rather than drawing a \ through it.

BKondel On|Off<Return>

Required for Pet: Erase backspaced characters.
BKondel On

Models:
All



 CASedisp

The CASedisp command permits the setting of the case of the characters that the TNC sends to PeT. 

CASedisp n<Return> Where:
 n = 0, don't alter case.
 n = 1, change all to lower case.
 n = 2, change all to upper case.

Recommend PeT Setting: Do not alter case.
CASedisp 0

Models:
AEA

Others See: 
Lcok

  



 CBell

The CBell command enable or disables the TNC's feature that rings the terminal's bell 3 times when a 
***CONNECTED or ***DISCONNECTED message appears.

CBell On|Off<Return>

Recommended PeT Setting: Disable TNC    Connect bells.
CBell Off (PeT handles bell internally)

Models:
AEA



 COMmand

The COMmand command is used to take the TNC from Converse or Transparent modes, and place it in 
Command mode. At any rate, it should have the same settings as configured in PeT's @TNC 
Parameters@ dialog.

COMmand n<Return> Where n =                                     $00 to $FF on Kantronics.
$00 to $7F on Others.

Recommend PeT Setting: Use Control-C
COMmand $03 Default

Models:
All



 CONMode

The CONMode command is used to set the mode that the TNC will be placed in after a connection takes 
place.

CONMode COnvers/TRans<Return>

Recommend PeT Setting: Converse when Connected.
CONMode COnvers (usually the default setting)

Models:
All



 CR

The CR command adds the SENDPAC character (usually $0D) to packets sent in Converse mode each 
time the <Return> key is depressed.

CR On/Off<Return>

Recommend PeT Setting: Send Packet on <Return>.
CR On<Return> (Usually the TNC default)

Models:
All



 DELete

The DELete command is used to choose the method the TNC will use to delete characters when the 
backspace key is used.

DELete On/Off<Return> 

Recommend PeT Setting: 
DEL Off

Models: 
All



 ECHO

The ECHO command controls the echoing of characters sent to the TNC. PeT automatically sets ECHO 
Off when it starts.    Since PeT is a split screen terminal program, it is not normally necessary or disirable 
to have characters echoed.    If ECHO is set to On, you will see you Terminal mode keystrokes printing in 
both the Receive and Transmit Panes. 

ECHO On/Off<Return>

Normal PeT Setting: Do not echo Xmit bytes to Recv Pane.
ECHO Off TNC Default is On! 

Pet Tips: 
You may wish to set ECHO On when you want to save a complete copy of a conversation to disk.

If you normally want to have ECHO On, put the line ECHO On in your Startup.mac file and turn 
the @Startup Player@ to On.

Models: 
All



 ESCAPE

The ESCAPE command if enabled will cause the EsC character ($1b) to be modified to a ($24).

ESCAPE On/Off<Return> 

Recommended PeT Setting: Do not alter Escape character.
ESCAPE Off (usually default setting)

Models: 
All



 FLOW

The FLOW command enables TNC "type in" flow control. Any character typed into PeT in Transmit mode 
will cause all received text to be halted! This is not necessary or desirable for split screen operation. PeT 
automatically sets FLOW Off at startup.

FLOW On/Off<Return> 

Recommended PeT Setting: Do not halt Recv text!
Flow Off TNC default is usually ON! 

Models:
All



 HOST

The HOST command is used to place the TNC into HOST mode, a special interface for communication 
between a TNC and computer terminal software. HOST mode is not standardized between different TNC 
models / manufacturers.

If you are using PKGOLD or other HOST MODE SOFTWARE, make sure you exit to Command Mode, 
before attempting to run PacketPeT.

HOST On/Off<Return> 

Required for PeT: 
Leave HOST Off when operating PacketPeT! 

Models: 
AEA 
Others



 INtface

The INtface command is used    by Kantronics to switch between various TNC operational modes.

INtface TERMINAL/BBS/HOST/KISS<Return> 

Required for PeT: 
INtface TERMINAL

HOST mode is a special interface for communication between a TNC and computer terminal 
software, but HOST mode is not standardized between different TNC models / manufacturers.

If you are using Host Mode software prior to running PeT, make sure you exit to Command Mode before 
attempting to run PacketPet!

Models: 
Kantronics



Recommended PeT Setting: 
CHSwitch $00 During Xmodem transfers! 
CHSwitch $7C Multiple Connects.

CHSwitch is SUPPOSED to be ignored in Transparent Mode, but binary transfers attemped on an AEA 
PK-88 failed unless CHSwitch was set to $00.



CMndtime Seconds

On most TNCs the CMntime is set to the number of 1 second intervals. On those TNCs use the setting 
CMdtime 1<Return>.

On AEA TNCs the CMntime is set to the number of 100 millisecond or 1/10 second intervals so the setting 
CMdtime 10<Return> must be used, which is still equal to 1 second.

In either case, the TNC's default setting is usually 1 second.



 Lcok

The Lcok command is used to prevent the TNC from translating lower case letters (test text) into uppper 
case letters (TEST TEXT). 

Lcok On/Off<Return> 

Recommended PeT Setting: Enable Lower Case display.
Lcok On (default)

Models: 
All but AEA

AEA See: 
CASdisp



 Parity

The Parity command    selects the Parity that the TNC's serial port uses to communicate with the 
computer. The new setting takes effect when the TNC is restarted.

PARity n<Return> 
Where:

TNC1/HD-4040/ n = 0 | odd
Kantronics n = 1 | even

n = 2 | mark
n = 3 | space
n = 4 | none

TNC2/AEA n = 0 | none
n = 1 | odd
n = 2 | none
n = 3 | even

Recommended Pet Setting: Parity None needed for Xmodem.
PARity 4 NO Parity (TNC1/HD-4040/Kantronics)
PARity 0 NO Parity (TNC2/AEA)

To Set Pet's Parity use Settings|Serial Port.

Models: 
All



TNC Parity 

Parity none is    recommended.

PARity 4<Return> TNC1/HD-4040/Kantronics

PARity 0<Return> AEA/TNC2 clones



 STArt

The STArt command is used to select the character byte that is used to restart the TNC output to PeT 
after the STop character has been previously used to halt output. The STArt character (Ctrl-Q) is normally 
typed in from the keyboard,    but PacketPeT also sends this character when the Recv Panes Vertical 
Scroll Bar is restored to it's home position.

STArt n<Return> n = $00 to $7F

Required PeT Setting: Use Control-Q for Start character.
STArt $11

Models: 
All

See:
STOp



 STOp

The STOp command is used to select the character byte that is used to stop the TNC output to PeT. The 
STOp character (Ctrl-S) is normally typed from the keyboard,    but PacketPeT also sends this character 
when the Recv Panes Vertical Scroll Bar is moved upward to view previously received text. At this time, 
the word Recv Offset will be displayed. TNC output is restarted by returning the Scroll Bar to it's home 
position, or by sending the STArt character (Ctrl-Q).

STOp n<Return> n = $00 to $7F

Required PeT Setting: Use Control-S for Stop Character.
STOp $13

Models: 
All

See:
STArt



 XFlow

The XFlow command determines the type of flow control that will be used by the computer's serial port 
and the TNC.

XFlow On/Off<Return> On - Use Xon/Xoff characters    (Ctrl-Q/S)
Off - Use only hardware flow control.

Required PeT Setting: Use hardware flow control.
XFlow Off Default is On!

Models: 
All



 Paclen

The Paclen command determines the point at which the TNC's Transmit buffer will automatically be sent. 
Paclen is used by both Transparent and Converse modes.

Paclen n<Return>Where n = 1 to 256.

Recommended PeT Setting: Send when 128 bytes long. 
Paclen 128 Default 128

Models: 
All



 Screenl

The Screenl command limits line length to n characters by adding a <cr> <lf> sequence which generates 
a new line. PacketPeT handles this feature internally, and will usually break a line between words, 
rather than in the middle as Screenl does.

Screenl n<Return> Where n = 0 to 255.

Recommend PeT Setting: Disable Screenl, set to zero. 
Screenl 0 Default setting is 80!

Models: 
All except AEA

See: 
AEA ACRDisp



 ACRDisp

The ACRDisp command limits line length to n characters by adding a <cr> <lf> sequence which 
generates a new line. PacketPeT handles this feature internally, and will usually break a line between 
words, rather than in the middle as ACRDisp does.

ACRDisp n<Return> Where n = 0 to 255.

Recommend PeT Setting: Disable ACRDisp, set to zero.
ACRDisp 0 Default setting is 80!

Models: 
AEA only

See: 
Others Screenl



 About PacketPet Lite

              Registered About Box

            Unregistered About Box

Register PeT Lite



 The Streams Menu

The Streams Menu provides a method to switch the main receive pane between the raw IO (*All IO) and 
the filtered A - Stream.

 * All IO
-----------------
 0 - A
-----------------
 ? CSTATUS



 Streams | Cstatus

The CSTATUS dialog box shows the connect status of the current channel.



 Settings | ANSI Color

This option enables or disables the ANSI color graphics reception in the A - Stream Pane. 

When in ANSI mode, you do not have the scroll back buffers available on the stream, but you do have a 
complete record of received text in the *ALL IO buffer.

Hot Key: 

Registration Required! - This feature will not operate until your CALLSIGN and user PASSWORD have 
been entered. 

Registration



 Settings | ANSI Reset

This command resets the Ansi Terminal emulation to to it's default colors, white text on a black 
background. 

If you receive a mis-behaved graphic that does not reset your terminal to it's original colors at the end of 
it's display, or should you copy only a portion or a graphic, your terminal colors could be left in pink on a 
green background or some other strange color combination. The Ansi Reset command is a quick way to 
restore the proper color settings to the terminal.

Hot Key: 

Registration Required! - This feature will not operate until your CALLSIGN and user PASSWORD have 
been entered. 

Registration



 PacketPeT For Windows - RETAIL Version

Support for the Kam/Kam+ dual port controller in the retail version of PacketPeT.

Includes support for 10 VHF and 10 HF streams.

Each stream has it's window and data buffers. 

Stream selector button letters flash when new text arrives on a stream not currently 
displayed. 

Clicking on the Stream Button takes you to that stream. 

If someone connects on a different stream, you are notified in the same way you would be 
if you had the PeT window totally hidden and someone connected.



The CSTATUS box shows the status of all of the streams!



 PacketPeT For Windows - RETAIL Version

Support for the AEA PK88 & PK232 controllers in the retail version of PacketPeT.

Includes support for Channels.

Each Channel has it's window and data buffers. 

Channel selector button letters flash when new text arrives on a channel not currently 
displayed. 

Clicking on the Channel Button takes you to that Channel. 



The CSTATUS box shows the status of all of the streams!



Pet lets you know when someone connects, even if you have another Windows programing running full 
screen at the time!



 PacketPeT For Windows - RETAIL Version

Support for the TNC2 compatable controllers. (This is many of them!)

Stream selector button letters flash when new text arrives on a stream not currently 
displayed. 

Clicking on the Stream Button takes you to that stream. 

If someone connects on a different stream, you are notified in the same way you would be 
if you had the PeT window totally hidden and someone connected.



The CSTATUS box shows the status of all of the streams!



 Settings | Directories

The Directories command opens a dialog box which permits adjustment of the paths that PacketPeT uses 
for it's key files.

Paths are created during installation.    Use this dialog to alter paths and then answer OK to save them. 
The directories must be created before you attempt to have PeT use them!

Root Path:
PacketPeT Lite's main working directory.

Connects Path: 
This is the place that PeT uses to store *.CON files.

Log Path: 
This is the place that PeT stores *.LOG files.

Monitor Path: 
This is the place that PeT stores *.MON files.

Note: 
The Directory Settings are saved in the file SETTINGS.PET.



 Settings | Packet

This option enables or disables Packet support, and put's PzeT into a mode friendly to Pactor and other 
rtty / cw modes.

When Packet is off, the left hand corner box which normally shows Connects:Y, will display the words 
Packet Off. 

When Packet is off, PeT will still react to ***Connected and ***Disconnected messages, but will not 
verify this information.    This permits the logging and Save Connects features to operate in Pactor, just as 
they would in packet.

Also, when a ***Connected message is received, PeT will send the prompt "DE MYCALL PacketPeT>" to 
the other station! Where MYCALL = the call of the registered user!

Packet should be On when operating Packet, and Off when operating other CW or RTTY modes, 
including Amtor, Pactor and RTTY. 

Registration Required - This feature does not operate until you have entered your Callsign and user 
Password.

Registration



 Contacting Chuck For Help

If after consulting the supplied documentation you still need additional help, Call:

Chuck Harrington at (407) 679-9017 or leave EMAIL at the following online services:

Ameica Online - ID is    ChuckORL
Compuserve - ID is    72067,3514
Genie - ID is    C. Harrington

If you elect to telephone, the best chance of talking to Chuck is in the mornings, Eastern Standard 
Time. At other times, an answering machine is online and calls are returned as soon as possible 
(to continental U.S.), usually within 24 hrs.


